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Section 1 GEMPREP Notes

While preparing the GEM Desktop™ for use on vyour computer , the
GEMPREP program displays the following message:

insert your DOS disk containing FORMAT.COM into drive A.

GEMPREP displays a similar message that requests you to place a DOS
disk containing MODE.COM into drive A.

The executable files for the FORMAT and MODE programs under some
versions of the MS-DOS operating system have extensions of EXE.
This presents a problem because the GEMPREP program looks. For
FORMAT.COM and MODE.COM, not FORMAT.EXE and MODE.EXE.

If you are using version 3.2 of MS-DOS, you can correct this situation
by renaming FORMAT.EXE and MODE.EXE to FORMAT.COM and
MODE.COM, respectively. You should rename these files before using
the GEMPREP program. Rename them only on a copy of your MS-DOS
system disk, not on the original. Consult vyour operating system
documentation if you are unfamiliar with the RENAME command.

If you are using another version of MS-DOS, rename FORMAT.EXE and
MODE.EXE to FORMAT.COM and MODE.COM on the copy of your MS-
DOS system disk that you’ll use during GEM installation. After you
have installed GEM, change FORMAT.COM and MODE.COM back to
FORMAT.EXE and MODE.EXE on the copy of the MS-DOS system disk.
You also need to rename these files in the root directory of your hand
disk, or if you're using a dual-floppy only system, in the GEMSYS
folder.

Then, when you need to format a disk while using the GEM Desktop,
use the Enter DOS commands.... command from the Options Menu.
When the DOS command line prompt appears, enter the FORMAT
command as described in your MS-DOS documentation.
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Section 2 GEM Setup Notes

The GEM Setup program accounts for the hard disks in your system
according to the hard disk icons displayed on the Desktop. When vyou
use GEM Setup to make changes in your system’s configuration, it
searches the first hard disk for the configuration information stored in
a file named ASSIGN.SYS. This can present a problem on systems
with more than one hard disk drive.

If you have GEM installed on a hard disk other than C (the first hard
disk), you must temporarily remove the icon for drive C before using
GEM Setup to change your system’s configuration.

Here are the procedures to follow when running GEM Setup on
systems with GEM installed on a hard disk other than drive C:
1. Select hard drive C by clicking on its icon.
From the Options Menu, click on Install disk drive...

Select Remove from the dialog. This temporarily removes the
icon for drive C. The drive C icon will return when you restart
the system.

4, Repeat steps 1, 2, and 3 for each hard disk drive icon that
preceeds the one on which you have installed the GEM
Desktop.

5. Start GEM Setup--it will now search the remaining hard disk
drive for the configuration information (ASSIGN.SYS) it needs.

Running GEM Setup on Dual-Floppy Systems

Note: This information supplements page 17-1 of the GEM Desktop
manuat.

If you're running GEM Setup on a system that has only floppy disk
drives, place the Device Driver Disk #1 in floppy drive B (this is the
disk that contains GEMSETUP.APP). Select drive B and then double-
click on the icon for GEMSETUP.APP.
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If you're using GEM Setup from a GEM Device Driver Pack on vyour
dual-floppy system, you must also run the program from drive B.

The directions on page 17-1 of the manual assume a hard disk

configuration and instruct you to place the Device Driver Disk #1 in
drive A.

Section 3 Plotter Support and Installation

GEM Desktop 2.1 supports the following plotters:
Hewlett-Packard® 7585 Hewlett-Packard 7475A
Hewlett-Packard 7470A Hewlett-Packard 7550A
Hewlett-Packard 7440 IBM® 7372

After checking your plotter documentation for the proper procedures,
configure your plotter as follows:

Baud Rate 9600

Parity none
Word Length 8 Bits
Stop Bits 1

Make sure the plotter is connected to your computer using a cable
configured in accordance with your plotter documentation.

Install the appropriate driver and make the proper port assignment
using GEM Setup. (See pages 18-3 and 18-4 of your GEM Desktop
guide.) After saving the new Summary, restart the GEM Desktop.
Your plotter should now be ready for use with GEM.
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Section 4 Using GEM With Concurrent or DOS Plus

The GEM SYSTEM MASTER DISK version 2.1 includes two files that
allow you to use GEM software with the Concurrent™ or DOS Plus ™
operating systems. These files are named:

DESKHD.CPM
DESKFPY.CPM

If you plan to use the GEM Desktop with one of these operating
systems, first make a copy of the GEM SYSTEM MASTER DISK. Then
delete the following files on the copy:

DESKHD.INF
DESKFPY.INF

Rename the two CPM files to .INF. The .INF files inform the GEM
Desktop that CMD files are executable.

End of Release Note
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Foreword

Welcome to GEM Desktop™ the electric desk for your personal
computer!

The GEM Desktop is designed to look and operate similar to a desk in
your home or office. You'll find it helpful to keep this metaphor in
mind while learning about the GEM Desktop.

This GEM Desktop guide is divided into four major parts, which are
further subdivided into individual sections. The following is a brief
outline of the contents.

Part 1 introduces you to the GEM Desktop and explains what you must
do to prepare the desktop to work on your computer. [t contains the
following sections:

® Section 1 is an overview of what the GEM Desktop does and how
it works. You'll also find technical information in this section
about the computer hardware you can use and some other basic
requirements.

® Section 2 takes you step-by-step through the things you must do
to prepare your computer to use the GEM Desktop.

® Section 3 is a tutorial that acquaints you with basic operations of
the GEM Desktop, such as how to start it on your computer.

Part 2 contains reference material describing individual components of
the GEM Desktop.
® Section 4 describes the "windows” you see on the GEM Desktop.

® Section 5 discusses the “electronic folders”, where you store
electronic information, such as pictures and documents.

® Section 6 talks about GEM Desktop icons.

® Section 7 discusses applications you can use with the GEM
Desktop.

® Section 8 explains how to work with “dialogs”. These are
messages that help you communicate with the GEM Desktop.



® Section 9 explains how the GEM Desktop menus and commands
work.

Part 3 describes GEM Output™ This is a program provided on one of
your GEM Desktop product disks. You can use this program to
reproduce documents on your monitor screen, printer, plotter, or
camera.

® Section 10 is an overview of GEM Output.

® Section 11 explains how to start GEM Output and also
demonstrates its use.

® Section 12 shows you how to create lists of documents you want
to reproduce with GEM Output.

® Section 13 explains the different ways you can control how your
printer, plotter, monitor screen, or camera works.

® Section 14 describes the GEM Output menus and commands.

® Section 15 describes the Print Spooler desk accessory.

Part 4 describes GEM Setup™ This is another program provided on
your GEM Desktop product disks. You use this program to tell the
GEM Desktop you have made a change to your computer equipment.

® Section 16 is an overview of GEM Setup and explains when you
should use the program.

® Section 17 explains how to start GEM Setup.
® Section 18 explains how to use GEM Setup.
® Section 19 describes the GEM Setup menus and commands.

Your GEM Desktop guide also contains a Glossary and an Index.

We recommend you use your GEM Desktop guide in the following way:

1. Skim through sections 1 through 3 for the “flavor and content” of
the GEM Desktop.

2. Read the Glossary at the end of the guide.



3. Re-read sections 2 and 3 and complete the steps as instructed.

4. Study sections 4 through 9 closely. Use these sections as
reference when you need to understand how the GEM Desktop
operates.

5. Study part 3 to learn about GEM Output.

6. Briefly read part 4, section 16 to learn about GEM Setup. Read
the remaining sections if and when you need to run the program.

Assumptions and Conventions

Unless otherwise stated, the examples in this guide assume your
computer has one floppy disk drive (drive A) and a hard disk drive
(drive C).

This guide also assumes you have a mouse or other pointing device
attached to your computer. If you don’t, you can learn how to use
your keyboard in place of a mouse by studying your GEM Desktop
Keyboard Reference provided at the back of this manual.

All GEM Desktop, GEM Output, and GEM Setup commands appear in
boldface. Some commands, when appearing in menus, are followed by
three dots to indicate that a dialog appears when you choose the
command. For example, when you choose the Open.. command from
the File Menu, the ITEM SELECTOR dialog appears. However, the three
dots are omitted when the commands appear in the text of the GEM

Desktop guide.
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SECTION 1

GEM Desktop Overview

The GEM Desktop is a graphics-based application program. It
occupies a portion of your computer's memory between you and your
operating system, as the following figure illustrates: '

Computer Memory (RAM)
GEM Operating
Desktop System

The primary purpose of the GEM Desktop is to make your computer
and its operating system easy to use. It does this by replacing cryptic
commands with visual objects. For example, to copy three items from

a floppy disk to a hard disk using your operating system might require
that you enter the following commands:

COPY C:\EXPENSES\JAN-PAY.RPT A:\TAXES-86\JAN-PAY.RPT/V
COPY C:\EXPENSES\FEB-PAY.RPT A:\TAXES-86\FEB-PAY.RPT/V
COPY C:\EXPENSES\MAR-PAY.RPT A:\TAXES-86\MAR-PAY.RPT/V
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GEM Desktop

When you use the GEM Desktop to do the same operation, pictures of
the objects you are copying appear on your screen. You use your
mouse as if it were an extension of your hand. The next illustration
shows what you see on your screen when doing this operation:

File Options Arrange DESKTOP
i et ot : T o
M C:\
New Folder GAMES GEMAPPS GEMBOOT GEMDESK GEMSVS ICONS i
IMAGES PICTURES REPORTS SAVE SCREENS SN TABLES WS i

ANSI.SVS QUTOEXEC BAT BASICAR.COM CHKDSK.COM COMMAND . COM CONFIG.SYS DISKCOPY.COM EDLIN.COM
i 6 S i e B i B f

R \TQXES~86\

New Folder FEB-PAY.RPT Il JAN-PAY.RFT Ml MAR-PAY.RPT

As you can see, doing operations on the GEM Desktop is close to the
way you do things in the “real world”. Your GEM Desktop guide
shows you how to do this and other operations on the GEM Desktop.
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GEM Desktop System Requirements

SYSTEM REQUIREMENTS

Your computer system must meet certain minimum requirements
before you can use it with the GEM Desktop. This section explains
these minimum requirements.

Computer Requirements

The GEM Desktop operates on the IBM® PC, XT® AT® and all 100%-
compatible computers.

Your computer must have a graphics card installed.

You can also do all GEM Desktop operations directly from your
keyboard. However, you’'ll find the desktop easier to use if you have a
mouse or graphics tablet.

Your computer must have at least two disk drives. You can have
either two floppy drives or one floppy drive and one hard disk drive.

For floppy disk systems, the GEM Desktop and GEM™ applications
require double-sided, double-density disks.

Operating System Requirements
You can use the GEM Desktop with the following operating systems:
® MS®-DOS version 2.1 or higher.
® PC DOS version 2.0 or higher.
® GEM DOS™
® DOS Plus™

End of Section 1
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SECTION 2

Getting Started

There are some things you must do to prepare your computer to use
the GEM Desktop. This section explains the required steps.

You have several options while preparing the GEM Desktop to run on
your computer. Therefore, you should study this entire section before
you begin so you'll be ready to choose the options you want at the
proper time.

CHECK CONTENTS OF GEM DESKTOP PACKAGE

Your GEM Desktop package contains the following disks:

® GEM System Master Disk

® GEM Device Driver Disk #1
® GEM Device Driver Disk #2
® GEM Device Driver Disk #3
® GEM Device Driver Disk #4

THINGS YOU WILL NEED

To prepare the GEM Desktop to run on your computer, there are some
things you will need, as explained below:

® A DOS system disk from which you can boot your operating
system. The disk must contain the software items
COMMAND.COM, MODE.COM, and FORMAT.COM.

® Five floppy disks on which you can copy your original GEM
Desktop product disks.



Copy Product Disks GEM Desktop

® |f you are going to run the GEM Desktop from floppy disks, you’ll

need two more floppy disks. We recommend you use new disks
because they are more reliable.

You need to know what type of graphics card is installed in your
computer.

If you have a mouse, printer, or plotter attached to your computer,
you need to know the type of each device and how it is attached.
Read “Communication Ports” and “If You Have a Serial-type
Printer” later in this section for information about how such
devices can be attached and used with your computer.

If you have a MicroSoft® Bus-type mouse, you'll need the disk
containing your MOUSE.COM software. You received this
software with your mouse. See “If You Have a MicroSoft Mouse”
later in this section to determine whether yours is a Bus-type or
Serial-type mouse and, if a Bus-type, whether or not it is
correctly set up to use with the GEM Desktop.

COPY PRODUCT DISKS

Your GEM Desktop product disks are not copy-protected. Copy all five
disks, store the originals in a safe place, and use only your copies
from here on.

if you don’t know how to copy disks, read about the DISKCOPY or
COPY command in your operating system manuals.
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GEM Desktop Start the GEMPREP Program

START THE GEMPREP PROGRAM

Your GEM System Master Disk contains a program named GEMPREP.
You must run this program to prepare the GEM Desktop to work on
your computer.

GEMPREP asks you questions about how you want the GEM Desktop to
operate and what types of devices (graphics card, mouse, and printer)
are attached to your computer.

Here’s how to start GEMPREP:

1. Insert your DOS disk in drive A.

2. If your computer is turned on, reboot the operating system by
pressing the Ctrl, Alt, and Del keys simultaneously. If your
computer is not turned on, turn it on now.

3. When the A> prompt appears, remove your DOS disk from drive
A and replace it with your GEM System Master Disk.

4. Type GEMPREP following the A> prompt and press Enter. You
see the following message:

Welcome to GEMPREP! This procedure will install the
GEM Desktop on your computer.

Do you want to put the GEM Desktop on a hard disk? (Y or N)

If you have a hard disk and want to run the GEM Desktop from there,
type Y. GEMPREP then asks if your hard disk is drive C (which is
normally the case). If it is, type Y. If your hard disk is not drive C,
type N and GEMPREP asks you to enter the correct drive letter.

If you don’'t have a hard disk, type N. (Even if you have a hard disk,
you can run the GEM Desktop from floppies if you prefer.)

2-3



Start the GEM Desktop GEM Desktop

Remember, if you're going to run the
GEM Desktop from floppy disks, you'll
need two additional disks to complete
GEMPREP. GEMPREP formats the disks

GEM STARTUP

when they're needed and asks you to
0 label them GEM STARTUP and GEM
@& DESKTOQOP.

From this point on, follow GEMPREP’s questions and menus carefully
through the conclusion of the program. If you make a mistake along
the way, replace the GEM System Master Disk in drive A with your
DOS disk, reboot your computer, then start over with this step. (You
can run GEMPREP as many times as you need or wish.)

START THE GEM DESKTOP

GEMPREP creates a batch file named GEM.BAT, which contains the
commands you need to start the GEM Desktop on your computer. (If
you want more information about how batch files work, read about
them in your operating system manuals.)

How you start the GEM Desktop depends on whether you put the
Desktop on a hard disk or on floppy disks. Instructions for starting
from either type of disk follow.

Start GEM Desktop from a Hard Disk

Assuming vyour hard disk is drive C, type each of the following
commands at your operating system prompt (A> or C>). Follow each
command by pressing the Enter key:



GEM Desktop Start the GEM Desktop

C:
CD \
GEM

In a few moments the GEM Desktop appears on your screen and
youre ready to start work. Before you move on to Section 3, you
might want to read “Start the GEM Desktop Automatically” later in this
section.

If the GEM Desktop doesn’t appear after you enter the GEM command,
you probably did not correctly answer one or more of GEMPREP's
questions. Review your answers and then rerun GEMPREP beginning
with “Start the GEMPREP Program” on page 2-3.

Start GEM Desktop from Floppy Disks

Insert your GEM STARTUP disk in drive A. Turn on your computer or, if
it's already on, reboot your operating system.

Type GEM following the A> prompt and press Enter. You then see
the following message on your screenr:

To continue, insert your GEM DESKTOP

disk into drive A:, and click on 0K, or

press the Enter key. To return to DOS,

click on Cancel.

Remove your GEM STARTUP disk from drive A and set it aside.

Insert your GEM DESKTOP disk in drive
A, close the drive door, and press
Enter. You see an hourglass icon on
your screen, telling you your computer
is busy completing your instructions.
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In a few moments, the GEM Desktop appears and you're ready to start
work. Before you move on to Section 3, you might want to read the
following section explaining how to “Start the GEM Desktop
Automatically”.

If the GEM Desktop doesn't appear after you enter the GEM command,
you probably did not correctly answer one or more of GEMPREP’'s
questions. Review your answers and then rerun GEMPREP beginning
with “Start the GEMPREP Program” on page 2-3.

START THE GEM DESKTOP AUTOMATICALLY

Every time you turn on your computer or reboot the operating system,
it looks for a batch file named AUTOEXEC.BAT. If it finds this file, it
completes the commands contained in that file before doing anything
else.

If you want to start the GEM Desktop automatically every time you
start your computer, you can create an AUTOEXEC.BAT file containing
the commands needed to start the GEM Desktop. This section
explains what you must do. Find the description that matches your
situation and follow the instructions.

Note: Be sure you complete the GEMPREP program before you take
any of the following steps.

If you put the GEM Desktop on a hard disk and you already have
an AUTOEXEC.BAT file on that disk...

You can use either of the following methods to create the
AUTOEXEC.BAT file you need:
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® Use the DOS COPY command to merge the GEM.BAT file with
your AUTOEXEC.BAT file. Type the following commands at your
operating system prompt (A> or C>). Follow each command by
pressing the Enter key:

C:
CDh \
COPY AUTOEXEC.BAT + GEM,BAT

® Use a word processor or text editor to add the command GEM at
the end of your existing AUTOEXEC.BAT file.

If you put the GEM Desktop on a hard disk and you don’t already
have an AUTOEXEC.BAT file on that disk...

® To create your AUTOEXEC.BAT file, type the following commands
at your operating system prompt (A> or C>). Follow each
command by pressing the Enter key:

C:
CD \
RENAME GEM.BAT AUTOEXEC.BAT

If you put the GEM Desktop on floppy disks...

GEMPREP does not create an AUTOEXEC.BAT file on your GEM
STARTUP disk. So, unless you created one on the disk after
completing GEMPREP, your GEM STARTUP disk does not contain an
AUTOEXEC.BAT file. To create an AUTOEXEC.BAT file, do the following:

1. Insert your DOS disk in drive A and either turn on your computer
or reboot the operating system.

2. Remove your DOS disk from drive A and replace it with your GEM
STARTUP disk.
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The GEM.BAT file you created with GEMPREP contains the
commands you need in your AUTOEXEC.BAT file. To create your
new AUTOEXEC.BAT file, type the following commands at your
operating system prompt (A> or C>). Follow each command by
pressing the Enter key:

A:

CDh \
RENAME GEM,BAT AUTOEXEC.BAT

COMMUNICATION PORTS

If you have a mouse and/or printer attached to your computer, they
are physically attached to a “communication port”. GEMPREP asks you
to identify the communication port to which each device is attached.

There are two types of communication ports: parallel and serial.
Normally, you can attach a device to one or the other type, but not
both. The type of communication port you attach the device to
depends on the device itself. The number and types of communication
ports vary with each computer.

It is beyond the scope of this guide to discuss communication ports in
detail, but we can suggest ways for you to find the information you
need if you don't already have it. If you're not sure how your mouse
and/or printer are attached, do either or both of the following:

® Contact your computer dealer or a systems specialist. These
individuals might be able to look at your computer and tell you
what you need to know about your communication ports.

® Use the “trial and error” method. This requires that you run
GEMPREP and “guess” which communication port your device is
attached to. If the device doesn’t respond when you run the GEM
Desktop, you must return to your operating system, restart
GEMPREP, and choose a different communication port for the
device that did not respond. Repeat the procedure until the
device responds.
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IF YOU HAVE A SERIAL-TYPE PRINTER

If you indicate to GEMPREP that you have a serial-type printer
attached to your computer, the program automatically creates a
document named CONFIG.SYS on either your GEM STARTUP floppy
disk or your hard disk. You must start your computer from the disk
that contains the CONFIG.SYS document. If you start your computer
from another disk and then start the GEM Desktop by entering the
GEM command, you probably won’t be able to print successfully.

If you subsequently add a serial-type printer to your computer and use
GEM Setup to add the printer to your setup (as described in Part 4 of
this guide), GEM Setup also automatically creates the required
CONFIG.SYS document. The above restrictions for starting the GEM
Desktop apply in this case as well.

Your printer manuals will tell you if your printer is a serial-type
device.

IF YOU HAVE A MICROSOFT MOUSE

There are two types of MicroSoft Mouse: a Serial Mouse and a Bus
Mouse.

The Serial Mouse plugs directly into one of your computer’'s serial
communication ports. Other than running GEMPREP, you don’t need to
do anything special to use the Serial Mouse with the GEM Desktop.

The Bus Mouse plugs into its own special interface board. The
interface board must be installed in one of your computer’'s expansion
slots.

You might have to make a minor adjustment on the interface board for
the Bus Mouse to work with the GEM Desktop. The adjustment,
however, isn't always necessary. You might want to try using your
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Bus
the

Mouse with the GEM Desktop before making the adjustment. I[f
mouse does not work correctly, you must make the following

adjustment:

1.

Turn off the power to your computer and remove the computer’s
outer cover according to the computer manufacturer’s
instructions.

. if the Bus Mouse interface board is already installed in your

computer, remove it from its expansion slot (see the
manufacturer’s instructions). If the interface board is not installed,
remove it from its package.

. Study the following illustration of the interface board. Then, look

at your own board and locate the four pairs of gold-colored pins
labeled 2, 3, 4, and 5, at the bottom center of the board.

. Find the “jumper” (a black and gold, box-like object) on one of the

pin pairs.

. If the jumper is on pin pair 3, the board is set up correctly.

Otherwise, gently remove the jumper from its present location
and place it on pin pair 3.

. Follow the manufacturer’'s instructions to install the interface

board.
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End of Section 2






SECTION 3

Getting Acquainted

This section acquaints you with some basic operations of the GEM
Desktop. It is written in tutorial style with accompanying illustrations;
however, your screen might look different from the illustrations
because the GEM Desktop is tailored to your specific machine.

In many cases, there is more than one way to do something on the
GEM Desktop. Most of the time we’ll show you only one way. You'll
learn about other ways when you read other sections of this guide.

The tutorial assumes you have a mouse attached to your computer. If
you don’t, you’'l need your GEM Desktop Keyboard Reference (provided
at the end of this manual) to do the exercises.

The tutorial also assumes you have successfully completed the
GEMPREP program described in Section 2. If you haven’t, you won't
be able to start the GEM Desktop.

To complete the tutorial exercises, you'll need a floppy disk. It should
contain at least one but, preferably, no more than fifteen items. And,
it would be best if the disk did not contain any directories. However,
the disk doesn't have to meet these requirements for you to use it
with the tutorial; it will just make things a little easier to understand.

START THE GEM DESKTOP

In Section 2 you learned there are several ways to start the GEM
Desktop. Refer to that section if you need help with this step.

When the Desktop first appears, it looks similar to the following
illustration. We've labeled the components you need to know about
for the tutorial. You'll learn more about these and other components
in later sections.
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Menu Titles Menu Bar Icons
File Options Arrange DESKTUP
H] C:\
New Folder GAMES GEMAPPS GEMBOOT GEMDESK GEMSVS TICONS IMAGES
- - [ ]
PICTURES REPORTS SAVE SCREENS SN TABLES WS AUTOEXEC.BAT

]
]
]

GEM.BAT GOEGA.BAT GOMERC.BAT BASICA.COM CHKDSK.COM COMMRND.COM DBISKCOPY.COM EDL IN.COM

] Disk Drives:

\

Disk Drive lcons Pointer

Note the two “windows” taking up most of the screen. The top
window shows icons representing the contents of the disk from which
you started the GEM Desktop. The icons in the bottom window
represent the disk drives on your computer.

Note: If the disk drive icons in the bottom window don’t match your
computer configuration, you can add and remove disk icons as
required. See the description of the Install disk drive command (page
9-8) when youre ready to do this. Note, however, that you can
complete the tutorial using the disk drive icons now on your screen.
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MOVE THE POINTER

The “pointer” (an arrow) moves on the Desktop when you move your
mouse. Practice moving the pointer, but for now, stay away from the
menu bar at the top of the screen. (If you accidentally make a menu
appear, move the pointer out of the menu into an open area, then
press and release the mouse button. If your mouse has more than
one button, use the one on the left.)

Sometimes the pointer disappears off the right side or bottom of the
GEM Desktop. To make it reappear, move the mouse in a large circle
a couple of times.

To move the mouse without moving the pointer, lift the mouse into
the air before moving it.

Pointer Techniques

You manipulate the pointer with your mouse, graphic tablet, or
keyboard to do a variety of Desktop operations. Most of the time
you’ll use one of the following pointer techniques:

® click

® double-click
® drag

® Shift-click

Sample operations using each technique follow.
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SELECT AN ICON (CLICK)

“Click” means press and immediately release the mouse button. You
click on an icon to “"select” it (The GEM Desktop and most GEM
applications work on the principle that you first select an object, such
as an icon, and then do something to that object either by direct
manipulation with the mouse or by choosing a command from a
menu.)

Let's select the drive A floppy disk icon.
Place the pointer on the icon and click
the mouse button. The GEM Desktop

"o ¢ highlights the icon vyou select by

1 - B0

' m HARD DISK placing a bold shadow around it.

Now move the pointer to an open area of the window and click again.
This “de-selects” the icon and the bold shadow disappears.

OPEN AN ICON (BOUBLE-CLICK)

“Double-click” means press and release the mouse button twice,
quickly. Double-clicking is an easy way to “open” an icon so you can
see what it contains. Try the following steps:

1. Insert the floppy disk you chose to use during the tutorial in drive
A and close the drive door.

2. Place the pointer on the drive A icon in the bottom window and
double-click.



